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Đề thi Tin học lớp 4 học kỳ 1 Số 1
	UBND HUYỆN ......

TRƯỜNG TH ........
	ĐỀ KIỂM TRA HỌC KÌ I
Năm học: 2022 - 2023
Môn: Tin học 4 Thời gian: 35 phút

	Họ và tên:.......................................

Lớp 4.......
	Điểm

............
	Giám thị

................................
	Giám khảo

………………………


I. Phần lý thuyết (4 điểm)
Em hãy khoanh tròn vào chữ cái đặt trước câu trả lời đúng. Mỗi câu trả lời đúng được 0,5 điểm/câu
Câu 1. Máy tính để bàn có mấy bộ phận chính?
A. 1 bộ phận
B. 2 bộ phận
C. 3 bộ phận
D. 4 bộ phận
Câu 2. Trong phần mềm Paint, để vẽ đoạn thẳng, em chọn công cụ:
A. [image: image1.png]



B. [image: image2.png]



C. [image: image3.png]



D. [image: image4.png]



Câu 3. Mô hình ba bước của quá trình xử lí thông tin là:
A. Xuất → nhập → xử lí
B. Nhập → xử lí → xuất
C. Xuất → xử lí → nhập
D. Nhập → xuất → xử lí
Câu 4. Trong phần mềm soạn thảo Word, để gõ kí hiệu @ em nhấn giữ phím:
A. Ctrl và gõ phím [image: image5.png]



B. Enter và gõ phím [image: image6.png]



C. Alt và gõ phím [image: image7.png]



D. Shift và gõ phím [image: image8.png]



Câu 5. Trong phần mềm Cùng học toán 4, để được máy tính trợ giúp khi làm bài, em nháy chuột lên nút lệnh:
A. [image: image9.png]



B. [image: image10.png]



C. [image: image11.png]



D. [image: image12.png]-




Câu 6. Trong phần mềm Paint, để sao chép một quả táo thành hai quả táo như hình dưới đây, em cần thực hiện theo thao tác nào?

A. Nhấn giữ phím Shift → sử dụng công cụ [image: image13.png]


 để chọn quả táo → kéo thả phần đã chọn tới vị trí mới.
B. Nhấn giữ phím Ctrl → kéo thả phần đã chọn tới vị trí mới → sử dụng công cụ [image: image14.png]


 để chọn quả táo.
C. Kéo thả phần đã chọn tới vị trí mới → sử dụng công cụ [image: image15.png]


 để chọn quả táo → nhấn giữ phím Shift.
D. Sử dụng công cụ [image: image16.png]


 để chọn quả táo → nhấn giữ phím Ctrl → kéo thả phần đã chọn tới vị trí mới.
[image: image17.png]



Câu 7. Trong phần mềm Cùng học toán 4, để thực hiện phép cộng, trừ các số có nhiều chữ số, em cần thực hiện theo thao tác nào dưới đây?
A. Thực hiện phép tính → nháy nút [image: image18.png]


 → nháy nút [image: image19.png]


 → nháy biểu tượng [image: image20.png]



B. Nháy biểu tượng [image: image21.png]


 → thực hiện phép tính → nháy nút [image: image22.png]


 → nháy nút [image: image23.png]



C. Nháy nút [image: image24.png]


 → nháy biểu tượng [image: image25.png]


 → thực hiện phép tính → nháy nút [image: image26.png]



D. Nháy nút [image: image27.png]


 → nháy nút [image: image28.png]


 → nháy biểu tượng [image: image29.png]


 → thực hiện phép tính
Câu 8. Để chèn tranh ảnh từ Clip Art vào văn bản, em thực hiện qua mấy bước?
A. 6
B. 3
C. 5
D. 4
II. Phần thực hành (6 điểm)
Câu 1. (3 điểm)
Hãy nêu các bước thực hiện viết chữ lên hình trong phần mềm Paint?
…………………………………………………………………………………………
…………………………………………………………………………………………
…………………………………………………………………………………………
Câu 2. (3 điểm)
Muốn thay đổi màu của hình văn bản em thực hiện như thế nào?
…………………………………………………………………………………………
…………………………………………………………………………………………
…………………………………………………………………………………………
Đáp án:
I. Phần lý thuyết (4 điểm)
Mỗi câu đúng được 0,5 điểm
	Câu
	1
	2
	3
	4
	5
	6
	7
	8

	Đáp án
	D
	C
	B
	D
	A
	D
	B
	A


II. Phần thực hành (6 điểm)
Câu 1. (3 điểm)
Câu 2. (3 điểm)
Đề thi Tin học lớp 4 học kỳ 1 Số 2
I. Phần lý thuyết (4 điểm)
Em hãy khoanh tròn vào chữ cái đặt trước câu trả lời đúng. (0,5 điểm/câu)
Câu 1: Trong phần mềm soạn thảo Word, em sử dụng phím Shift để:
A. Gõ chữ in hoa
B. Gõ kí hiệu trên của những phím có hai kí hiệu
C. Xóa kí tự
D. Cả A và B đều đúng
Câu 2: Bộ phận nào sau đây giúp em đưa “thông tin vào” để máy tính xử lí theo chỉ dẫn của chương trình?
A. Thân máy
B. Màn hình
C. Máy in
D. Bàn phím và chuột
Câu 3: Các bộ phận quan trọng nhất của một máy tính là:
A. Máy in, loa, chuột
B. Thân máy, màn hình, bàn phím, chuột
C. Màn hình, máy in, chuột
D. Thân máy, chuột, loa, máy in
Câu 4: Để vẽ hình chữ nhật, em sử dụng công cụ nào sau đây:
A. Công cụ [image: image30.png]



B. Công cụ [image: image31.png]



C. Công cụ [image: image32.png]



D. Công cụ [image: image33.png]



Câu 5: Trong các thiết bị lưu trữ sau đây, thiết bị lưu trữ nào là quan trọng nhất?
A. Thẻ nhớ
B. Đĩa cứng
C. Đĩa CD
D. USB
Câu 6: Để thoát khỏi phần mềm Mario, tại màn hình chính, em sẽ
A. Nhấn phím ESC trên bàn phím
B. Nhấn phím Shift trên bàn phím
C. Nháy chuột vào File → chọn Quit
D. Nhấn phím Enter trên bàn phím
Câu 7: Khi sao chép hình, em nhấn giữ phím gì trong khi kéo thả chuột?
A. Phím Shift
B. Phím Alt
C. Phím Ctrl
D. Phím Caps Lock
Câu 8: Máy tính điện tử đầu tiên có tên là gì?
A. ENIAC
B. IBM
C. HP
D. SAMSUNG
II. Phần thực hành (điểm)
Câu 1 (3 điểm):
Sử dụng phần mềm soạn thảo Word, hãy gõ nội dung sau:
Trong đầm gì đẹp bằng sen
Lá xanh bông trắng lại chen nhị vàng
Nhị vàng bông trắng lá xanh
Gần bùn mà chẳng hồi tanh mùi bùn
Câu 2 (3 điểm):
Sử dụng các công cụ đã học phần mềm Paint, em hãy vẽ hình sau đây, tô màu theo ý thích.
[image: image34.png]



Đáp án:
I. Phần lý thuyết (4 điểm)
Mỗi câu đúng được 0,5 điểm
	Câu
	1
	2
	3
	4
	5
	6
	7
	8

	Đáp án
	D
	D
	B
	C
	B
	C
	C
	A


II. Phần thực hành ( điểm)
Câu 1. (3 điểm)
1. Soạn thảo văn bản sai mẫu 2 lỗi, trừ 0,25 điểm.
2. Soạn thảo văn bản sai mẫu từ 3 đến 4 lỗi, trừ 0,5 điểm.
3. Soạn thảo văn bản sai mẫu từ 5 lỗi trở lên, trừ 1,0 điểm.
Câu 2. (3 điểm)
[image: image35.png]



1. Làm được ý 1 đạt 0,5 điểm
2. Làm được ý 2 đạt 1,0 điểm
3. Làm được ý 3 đạt 1,5 điểm
4. Làm được ý 4 đạt 2,0 điểm
5. Tô màu đạt 3,0 điểm
Đề thi Tin học lớp 4 học kỳ 1 Số 3 theo Thông tư 22
Ma trận số lượng câu hỏi và điểm:
	Chủ đề
	Số câu và số điểm
	Mức 1
	Mức 2
	Mức 3
	Mức 4
	Tổng điểm và tỉ lệ %

	
	
	TN
	TL/ TH
	TN
	TL/ TH
	TN
	TL/ TH
	TN
	TL/ TH
	Tổng
	TL

	Chủ đề 1: Khám phá máy tính
	
	
	
	
	
	
	
	
	
	
	

	1. Thao tác với tệp và thư mục
	Số câu
	2
	
	
	1
	
	
	
	
	3
	

	
	Số điểm
	1
	
	
	1
	
	
	
	
	2
	20%

	2. Internet
	Số câu
	
	
	1
	
	
	
	
	
	1
	

	
	Số điểm
	
	
	0,5
	
	
	
	
	
	0,5
	5%

	Chủ đề 2: Phần mềm đồ họa Paint
	Số câu
	2
	1
	
	1
	
	1
	
	
	5
	

	
	Số điểm
	1
	0,5
	
	0,5
	
	1
	
	
	3
	30%

	Chủ đề 3: Soạn thảo văn bản
	Số câu
	
	1
	1
	1
	
	1
	
	1
	5
	

	
	Số điểm
	
	0,5
	0,5
	0,5
	
	2
	
	1
	4,5
	45%

	Tổng
	Số câu
	4
	2
	2
	3
	
	2
	
	1
	14
	

	
	Số điểm
	2
	1
	1
	2
	
	3
	
	1
	10
	100%

	
	Tỉ lệ %
	20%
	10%
	10%
	20%
	0%
	30%
	0%
	10%
	100%
	

	
	Tỉ lệ
theo mức
	30%
	30%
	30%
	10%
	
	


Tương quan giữa lí thuyết và thực hành
	
	Số câu
	Điểm
	Tỉ lệ

	Lí thuyết (8')
	6
	3
	30%

	Thực hành (27')
	8
	7
	70%


Ma trận phân bố câu hỏi
	Chủ đề
	Số câu và số điểm
	Mức 1
	Mức 2
	Mức 3
	Mức 4
	Tổng

	Chủ đề 1: Khám phá máy tính
	Số câu
	2
	2
	
	
	4

	
	Câu số
	A.1, A.2
	A.3, B.1
	
	
	

	Chủ đề 2: Phần mềm đồ họa Paint
	Số câu
	3
	1
	1
	
	5

	
	Câu số
	A.4, A.5, B.2.1
	B.2.3
	B.2.2
	
	

	Chủ đề 3: Soạn thảo văn bản
	Số câu
	1
	2
	1
	1
	5

	
	Câu số
	B.3.1
	A.6, B.3.4
	B.3.2
	B.3.3
	

	Tổng
	Số câu
	6
	5
	2
	1
	14

	
	Số điểm
	3
	3
	3
	1
	10

	
	Tỉ lệ %
	30%
	30%
	30%
	10%
	100%


A. TRẮC NGHIỆM (3 Điểm) * Khoanh tròn vào câu trả lời đúng nhất:
Câu A1: (0,5đ) Đâu là biểu tượng của thư mục?
[image: image36.jpg]



Câu A2: (0,5đ): Để đổi tên thư mục em nháy nút phải chuột lên thư mục rồi chọn:
A. Delete
B. Copy
C. Rename
D. Open
Câu A3: (0,5đ): Để truy cập một trang web em thao tác theo thứ tự nào sau đây?
A. Khởi động trình duyệt/ Nhấn phím Enter /Gõ địa chỉ trang web vào ô địa chỉ.
B. Khởi động trình duyệt/ Gõ địa chỉ trang web vào ô địa chỉ/ Nhấn phím Enter.
C. Gõ địa chỉ trang web vào ô địa chỉ/ Khởi động trình duyệt/ Nhấn phím Enter
D. Gõ địa chỉ trang web vào ô địa chỉ/ Nhấn phím Enter/ Khởi động trình duyệt
Câu A4: (0,5đ) Trong phần mềm Paint, sau khi chọn một phần hình vẽ, để xoay phần hình đó em chọn nút lệnh nào?
A. Copy
B. Crop
C. Resize
D. Rotate
Câu A.5: (0,5đ): Trong chương trình Paint, phím tắt Ctrl + S dùng để làm gì?
A. Chọn toàn bộ tranh vẽ
B. Sao chép vùng tranh vẽ được chọn
C. Lưu tranh vẽ
D. Xóa tranh vẽ
Câu A.6: (0,5đ) Trong phần mềm Word, để chèn tranh ảnh vào văn bản em thực hiện thao tác nào sau đây?
A. Chọn Insert / chọn Table
B. Chọn Insert / chọn Picture
C. Chọn Insert / chọn Text Box
D. Chọn Insert / chọn WordArt
B. THỰC HÀNH: (7 điểm)
Câu B.1: (1đ): Tại ổ đĩa D tạo thư mục có tên lớp và SBD.
Ví dụ: Em học lớp 4-1 và số báo danh là 12 thì tạo thư mục là D:\ lop4-1-12
Câu B.2 (2đ) Phần mềm vẽ Paint
Câu B.2.1. (0,5đ) Mở phần mềm vẽ Paint
Câu B.2.2 (1đ) Vẽ hình theo mẫu sau, tô màu theo sở thích
[image: image37.jpg]



Câu B.2.3 (0,5đ) Lưu vào thư mục của em với tên ngoinha.png hoặc ngoinha.bmp
Câu B.3: (4đ) Soạn thảo văn bản
Câu B.3.1 (0,5đ) Mở phần mềm soạn thảo văn bản Word
Câu B.3.2 (2 đ) Gõ nội dung và bày đoạn thơ sau theo mẫu;
(Yêu cầu: - Chọn phông chữ Arial, cỡ chữ 16
- Trình bày kiểu chữ và căn lề theo mẫu)
EM YÊU NHÀ EM
Đoàn Thị Lam Luyến
Chẳng đâu bằng chính nhà em
Có đàn chim sẻ bên thềm líu lo
Có nàng gà mái hoa mơ
Cục ta, cục tác khi vừa đẻ xong…
[image: image38.jpg]



Câu B.3.3 (1đ) Chèn hình ảnh ngôi nhà đã vẽ ở câu 2 vào vị trí phù hợp ở văn bản trên.
Câu B.3.4 (0,5đ) Lưu văn bản soạn thảo vào thư mục của em với tên là baitho.docx
Đáp án đề thi học kì 1 lớp 4 môn Tin học
A. Phần lý thuyết: (3 điểm)
( Mỗi câu trả lời đúng được 0.5 điểm)
	Câu A1
	Câu A2
	Câu A3
	Câu A4
	Câu A5
	Câu A6

	A
	C
	B
	D
	C
	B


B. Phần thực hành: (7 điểm)
Câu B.1
- Tạo được thư mục theo yêu cầu được 1 điểm
Câu B.2.1
- Khởi động được PM Paint (0,5đ)
Câu B.2.2
- Vẽ được các chi tiết ngôi nhà (0,5đ)
- Tô màu phù hợp (0,5đ)
Câu B.2.3
Lưu được tranh vẽ vào đúng thư mục (1đ)
Câu B.3.1
- Khởi động được PM Word (0,5đ)
Câu B.3.2
- Gõ đầy đủ nội dung (1đ)
- Trình bày được theo mẫu (1đ)
Câu B.3.3
- Chèn được tranh vẽ vào văn bản và thay đổi kích thước phù hợp (1đ).
Câu B.3.4
- Lưu được văn bản vào thư mục (0,5đ)
Đề thi Tin học lớp 4 học kỳ 1 Số 4 theo Thông tư 22
PHẦN I: TRẮC NGHIỆM (4 điểm)
Em hãy khoanh tròn vào chữ cái trước đáp án đúng: (mỗi câu đúng được 0.5 điểm)
Câu 1: Trong hình bên, thư mục LOP 4.1 là thư mục con của thư mục nào?
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A. LOP 4
B. LOP 5
C. LOP 4.2
D. LOP 4.1
Câu 2: Công cụ nào là công cụ viết chữ lên hình trong Paint?
[image: image40.jpg]A7




Câu 3: Để đổi tên thư mục em thực hiện thao tác?
A. Nháy chuột trái → Chọn Rename.
B. Nháy chuột phải → Chọn Rename.
C. Nháy chuột trái → Chọn Copy.
D. Nháy chuột phải → Chọn Copy.
Câu 4: Em sử dụng công cụ nào để sao chép màu có sẵn?
[image: image41.jpg]B./7




Câu 5: Theo em việc tạo thư mục có tác dụng như thế nào?
A. Tạo thư mục giúp em lưu trữ thông tin và tìm kiếm thông tin một cách dễ dàng.
B. Tạo thư mục không lưu trữ được thông tin .
C. Tạo thư mục chỉ để xem cho vui.
D. Tạo thư mục chỉ để lưu hình ảnh.
Câu 6: Có mấy kiểu xoay hình trong Paint?
A. 2
B. 3
C. 4
D. 5
Câu 7: Trong Microsoft Word, để viết chữ lên hình lần lượt thực hiện các thao tác?
A. Nháy chuột trái vào hình → Add text → Viết chữ lên hình.
B. Nháy chuột phải vào hình → Add text → Viết chữ lên hình.
C. Nháy chuột trái vào hình → Paste → Viết chữ lên hình.
D. Nháy chuột phải vào hình → Paste → Viết chữ lên hình.
Câu 8: Trong Microsoft Word, để chèn đối tượng hình ảnh từ Clip Art vào văn bản em thực hiện
thao tác?
A. Insert → Clip Art.
B. Page Layout → Clip Art.
C. Home → Clip Art.
D. View → Clip Art.
PHẦN II: THỰC HÀNH (6 điểm)
Em hãy mở phần mềm soạn thảo văn bản Microsoft Word thiết kế theo mẫu sau?
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“Trong đầm gì đẹp bằng sen
Lá xanh bông trắng lại chen nhị vàng
Nhị vàng bông trắng lá xanh
Gần bùn mà chẳng hôi tanh mùi bùn”
Biển báo giao thông
[image: image43.jpg]



Yêu cầu
- Sử dụng phông chữ Time New Roman, cỡ chữ 14, kiểu chữ, màu chữ sao cho phù hợp.
- Tạo bài đầy đủ nội dung và chèn ảnh đúng yêu cầu (5 điểm)
- Chèn ảnh đúng chủ đề (0.5 điểm)
- Lưu bài trình chiếu vào ổ D với tên theo mẫu : Tên em + Tên lớp (Ví dụ : An 4.1) (0.5 điểm)
Đáp án Đề thi học kì 1 môn Tin lớp 4
Phần I: Lý thuyết: 4 điểm
Mỗi câu chọn đúng đáp án học sinh được 0.5 điểm
	Câu 1
	Câu 2
	Câu 3
	Câu 4
	Câu 5
	Câu 6
	Câu 7
	Câu 8

	A
	D
	B
	B
	A
	D
	B
	A


Phần II: Thực hành: 6 điểm
- HS mở được phần mềm Word (0.5 điểm).
- HS soạn được bài thơ và chèn như hình mẫu. Soạn không sai chính tả (2 điểm).
- HS chèn được hai hình biển báo (3 điểm).
- HS lưu được bài tên như đề bài yêu cầu (0.5 điểm).
